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1 Introduction
This document is a Systems Administrator's Guide for adding, changing, and deleting information to
Documentation Consultants SDLCforms documentation.
1.1 Purpose
This Guide will help users modify their documentation, which includes information on the following
topics:
o Document Properties
e Title Page
e Table of Contents
e Headers and Footers
e Document Format and Style
e Page Numbers
Note: This document is not intended as a training guide for either Microsoft Word or Excel. It will assist
in modification of Microsoft 2007/2010/2013 version documents.
1.2 Audience
This document is intended for system administrators, analysts, and technical writers who develop and
modify Documentation Consultants’ SDLCforms documentation.
1.3 General Form and Template Information

Documentation was prepared using standard template. Certain features and functions apply to all
documentation where applicable. In the majority of forms, the documents contain the following
information:

Title Page

Revision History

Copyright Notice and Confidential Statement
Table of Contents

Glossary of Terms

Appendix Section

Header and Footer information.

Text in Arial font using 11 point size.
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2 Word 2007/2010/2013 Styles

The vast majority of forms within each package are comprised of Microsoft Word forms and templates.
All of these forms have been developed using custom Word Styles. The list of these styles is shown
below to simplify your customization of these forms.

2.1 Accessing Word’s Styles

To access the styles, place your cursor in the line you wish to change, click on the Home Tab and then
the Styles Dialog Box Launcher (in the lower right hand corner of the Styles group).

4 Find -

5 Replace

rﬂj dhoCa Arial Slu A A‘| [E=

s copy = =
F Format Painter [B 7 U -abex x Aa||¥-A-|

* AaBbi o AaB AaBbCe AaBbCc AaBbCec AaBbCc AaBbCc 1 AaBbt AaBbCcl |AaBbCcl|| AaBbCel AaBbCcl

Sx- £ -] TBlueline .. TBlueline .. TBlueline.. TBlueline.. NBlueline .. NBlueline . NBlueline .. TBlueline .. TBodyTex.. |TBodyTex.. | TBodyTex. TBodyTex. — Change

Paste
- Styles~ || b Select~

Clipboard & Font = Paragraph o Styles i Editing
’4'
Styles Dialog Box Launcher
(71| Styles - X
[4] 5
Clear Al =
—— . )
e ™~ Operations Guide « Blueline Text Bulleted 1 T
( ) ProjectName
\ .. / Version o Blueline Text Bulleted 2 T
Blueline Text Centered hil
3.5.6 Datab Administration and Maint: Blueline Text Indent 1 T
Blueline Text Indent 2 Ell
Provide information and procedures about database administration and maintenance.
« Howto add, change, and delete: Blueline Text Left il
o Databases Blueline Text No Indent T
o Users, including the database administrator
o Userlogins and passwords Body Text Centered T
o Userand group access and permissions to datak entry, Jifi , deletion,
restoration, indexing, packing, backup, reporting, etc. Body Text Indented v
* Provide diagrams and flowcharts of the database structure and operations. Body Text No. 1 T
L N . Body Text No. 2 T
3.5.7 Monitoring, Troubleshooting, and Escalat
Body Text No. 3 T
Provide detailed system or application monitoring, troubleshooting, and escalation procedures.
Include information about: 1 Body Text Numbered v
¢ Bulleted No. 1 T
¢ Error messages
g o Bulleted No. 2 T
* Known problems
s Monitoring and ticket handling . Bulleted No. 3 T
* Log maintenance (e.g., how is it logged, where, by who, when)
s Escalation procedures and contacts. Centered
Company Name T
3.5.8 Backupand Recovery Copyright Text T
Provide detailed system or application backup and recovery procedures. Include information Document Date T
about: .
Document Title T
« Backups, restores, and recoverability Footer 12
s Scheduling procedures (e.g., when (frequency, time), where, how)
. Footer Confidentiality T
* Requirements
* Constraints Footer Document Number T
= Storage procedures (e.g., internal and external location, freguency, how it is stored, by
who, how long) Footer Page Number T
« Datapurging and archiving -
« Emergency worksites, e.g., facility location, equipment, contacts, procedures, etc. General Headmgs il
« Log maintenance (e.g., howis it logged, where, by who, when). Gray Banner T
Confidential - ©2014 Documentation Consultants (www.SDLCforms.com) Document: 1550 Page 12 of 14 Gray Banner Text T
Header bic}

Header Document Title T
Header Logo L

Header Project Name 7 |
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2.2 Word Custom Styles

Header Logo

Company Name

Header Document Title
Header Project Name
Header Version Number

Document Title

Document Date

Copyright Text
Table of Contents Heading

Table of Contents Numbered 1.......coovieiiiiiiiieeee e
Table of Contents Numbered 2.........coooveeeeiiiiieiiieeeeeenn,
Table of Contents Numbered 3......ccvvevevieeiiiieeen.

Gray Banner

1 Heading 1

1.1 Heading 2
1.1.1 Heading

General Headings

Body Text No. 1
Body Text No. 2
Body Text No. 3

Body Text Centered

Body Txt No. 1 Bolded
1 Body Text Numbered

e Bulleted No. 1
o Bulleted No. 2
= Bulleted No. 3

Note:

Blueline Text No Indent
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Blueline Text Left
Blueline Text Indent 1
Blueline Text Indent 2
Blueline Text Center
e Blueline Text Bulleted 1
o Blueline Text Bulleted 2
1 1 Blueline Text Numbered

Table Headings
Table Text
Table Text Centered
Table Text Bolded
e Table Text Bulleted
1. Table Text Numbered

2.

Footer Confidentiality
Footer Document Number
Footer Page Number

TOC1
TOC 2
TOC 3

2.3 Replacing the Blue Line Text

The blue line text embedded throughout each form provides instructions and suggested text entries for
each field on the form.These blue line entries should not appear in your finished document.

To replace a blue line entry, select the text, and click on the Delete button. However, the style will
remain as one of the many blue line text entries available in the Styles library (as shown above).

You will want to change the style for that entry to one of the styles corresponding to the type of text
entry you wish to replace it with, by clicking on the appropriate style in the Styles Dialog Box, such as:

Body Text No. 1
Body Text No. 2
Body Text No. 3
Body Text Centered

Table Text
Table Text Centered

Table Text Bolded
e Table Text Bulleted

Then type in the new text.
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3 Word 2003 Maintenance Information

Note: Although no longer supported, this section only applies if you are using Word 2003. If you are
using Word 2007/2010/2013, click here to review the instructions to modify Word 2007/2010/2013
forms.

The Document Properties area within the Microsoft software contains general information about the
document. Users should consider changing the Summary tab within the Properties page.

To access the Properties tab, click the following on the Main Menu bar on the top of the page:

e File and Properties

| Eile | Edit  Mjew Inse

Save a4s...

FPage Setup...
fj Brint...  Ckrl+P

Properkies

e Enter appropriate line item information within the Summary tab.

SDLCforms Systems Administratons Guide Propert...

General | JUMMary | Skakistics | Conkents || Cuskom

Title: SDLCForms Swskem Administrakor's Guide
Subject: |

Aukhor: Docurnentation Consulkants

Manager:

Company's

Category:
Keywords;

Corments:

Hyperlink,
base:

Template:  Mormal

I:l Save preview picture

[ Ok, ] [ Cancel
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3.1

Title Page

The Title Page contains initial descriptive document information. Users should change this information
to the specifics of the document. These items include the following:

e Body of Title Page
o Company Name
o Document Title

o Date
¢ Header and Footer Information:
o Header

=  Company Logo
= Document Type, e.g., Business Case, System Test Plan
= Document Title
= Project or Version Number
o Footer
= Confidentiality Statement and proprietary markings (short and long versions)
= Page Number

Modify Title Page Body Information
Scroll over the respective line and overwrite the appropriate information (use appropriate company font

and size where applicable):

o Company Name in Arial bold, 20 point size and centered
o Document Title in Arial bold, 28 point size and centered
e Date in Arial bold, 20 point size and centered

YOUR COMPANY NAME
DOCUMENT TITLE

DATE

Confidential - ©2014 Documentation Consultants (www.SDLCforms.com) Page 10 of 40
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3.2

e Change Title Page information to black by clicking the font color graphic on the Main Menu bar and
selecting black.

More Colors,..
Header and Footer
Modify Header Information:

To access the Header and Footer tab, click the following on the Main Menu bar on the top of the page:

e View Header and Footer
Wi | Insert  Formak  Too

Toolbars

Header and Footer

Markup

Z00M,.,

¥

The System will display the Header information corresponding to the page you are on, e.g.,

Analysis and Design Document
) , ProjectName
- Version

ii
4]
i

To move to other header or footer pages, click the respective icon on the graphic.

Header and Footer

Tnsert AutoText = | [ @ & FE 0 |22 E & 5, | dose

Confidential - ©2014 Documentation Consultants (www.SDLCforms.com) Page 11 of 40
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|4§ Ep | Close \

Swikch Bebween Header and Fu:n:nter|

= EE’ | Close \

Shiai F‘revin:nusl

H| Close

Show Mexk

To modify the sample company logo displayed on the title and other pages:

g

e Find your company’s logo graphic (in other documents or on your computer) and copy it.

e Return to your new document, click on the logo located in the header section, and paste your
company’s logo into the new document.

¢ Find all other sample logos by clicking the Show Previous or Show Next graphic on the menu bar to
move backwards or forward within the document

= |F |5, | Close
Shiai F‘revin:nusl

5, | Close

Show Mexk

To modify the document type, document title, and project or version number in the header:

e Move your cursor over each line item and type the respective information.

When complete:

o Close out the Header / Footer graphic bar by clicking the Close icon.

| EE & &, | close

Confidential - ©2014 Documentation Consultants (www.SDLCforms.com) Page 12 of 40
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or

e Switch to the Footer section to make appropriate changes by clicking the Switch Between Header

and Footer icon.
|4§ 5, | Close \

Switch Bebween Header and Foaker

Modify Footer Information:
To access the Footer tab, click the following on the Main Menu bar on the top of the page:

e View and Header and Footer

Wiew | Insert  Formak  Too

Toolbars 3

Headet and Fooker

Markup

Zoorn,.,.

w
W

o If the Header and Footer graphic is stilled displayed on the page, click the Switch Between Header
and Footer icon:

Header and Footer

Insert AutaText ~ |\ 3 &8 9| 22| E &3 5, dose

|45' 5, | Close \

Swikch Between Header and Fooker

To modify the confidentiality statement in the footer:

e Move your cursor over the statement and type the respective information.

Change the statement information to black by clicking the font color graphic on the Main Menu bar and
selecting black.

To modify the page number in the footer:

e Click the Insert Auto Text dropdown, Header/Footer, and Page X of Y icons.
e To change the page number in other sections of the document, find them by clicking the Show
Previous or Show Next graphic on the menu bar and repeat the above procedure.

Confidential - ©2014 Documentation Consultants (www.SDLCforms.com) Page 13 of 40
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Header and Footer

Insett AutoText = [ = = & 9 | da
Atkention Line »
Closing »
Header/Footer » | - PAGE -
Mailing Inskruckions  » Author, Page #, Date
Reference Initials — » Confidential, Page #, Date
Reference Line 3 Created by
Salukation .3 Created on
Signiakure 3 Filename
Signature Company » Filename and path
Subject Line 3 Last printed
Last saved by
Page ¥ of ¥

o When complete, close out the Header / Footer graphic bar by clicking the Close icon.

3.3 Revision History

Update the Revision History Section by entering the respective information.

Date Version Author

Confidential - ©2014 Documentation Consultants (www.SDLCforms.com) Page 14 of 40
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3.4 Copyright Notice

Update the Copyright Notice Section by changing the respective information.

Example:

CORYRIGHT NOHECE

Copyright© 2016 "Decumentation/ Consultants:
Allrights’teserved: These.materials“areforinternaluse/only. No‘part.of these.materials.may.be
reproduced; published.manytorm-or.byany.means, electronic.or mechanical including photacopy.orany
infermationstorage’.ovretrieval systeminor.maytheimatetials be' disclosed tolthirdpartissimihout the written
authorization-of. Bocumentation<Gonsultants:

3.5 Table of Contents

e To create the Table of Contents, click the following on the Main Menu bar on the top of the page:
Insert, Reference, and Index and Tables.

Inserk Farrnak

Tools Tahle wyindawe Help

Break...

AukoTexk
Field. ..
Svmbol, ..

Commenk

b oS - | e

Page Mumbers. .. | =
= B 7 U | gl
= Date and Time. ..

L AL B

Reference

L4 | Footnote. ..

Lol A

web Component. .. Capkion...

Picture

K nﬂ

Diagrarn. ..

[y
[

T

Texk Box
File...
object. ..
Bookmark. ..
% Hyperlink. ..

3 Cross-reference. ..

| Index and Tables...

CErlHK
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e Click the Table of Contents tab.

Index and Tables

X

Index | Table of Contents | Table of Figures | Table of guthorities

Prink Prexview Web Preview
Heading 1................................ 1 || [Heading 1 s>
Heading 2. ... = Heading 2
Heading 3 ... 5 Heading 3
~ ~
Show page numbers Use hyperlinks instead of page numbers

Right align page numbers

Tab leader: |....... s
zeneral

Farmats: From template |'v_ Show levels: |3 ES

[ Options. .. ] [ Modify ... ]

Distinctive

Fancy

Modern I
Formal
Simple

Ok ] [ Cancel ]

e Select the format from the From Template drop-down box.
e Select the number of levels from the Show Levels drop-down box.
e Click the OK box when finished.

Example:

TABLE OF CONTENTS
I 11 4
1.1 = = =T o= T =T = OO P RSSO 4
2 System Test DeSCriPtion . i s s s 5
21 IR a1 == OO OO TR ]
2.2 Test Entrance and Exit Criteria. 5
221 Entrance Critefia................ .8
2212 Exit Criteria ... 5
2.3 IR =TT = 1= OO OO g
3 System Test APProach . r e e e e e s e e e e e e nee s e amnens 6

e To update the Table of Contents, click the contents of the Table of Contents and the following
display box will appear.
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..... ;Dp':..'
-4 |2y Paste

----- =¥ Update Field

..... Edit Field. ..

Toggle Field Codes

..... A Fank...

..... =9 Paragraph...

1 :=  Bullets and Murmbering. ..

o Click the Update entire table radio box, and then press the OK box when finished.

Update Table of Contents |

Wiord is updating the table of contents. Select one
aof the fFollowing options;

(") Update page numbers only

(] 4 ] [ Zancel

3.6 Glossary

Update the Glossary Section table (if applicable) by entering the respective information.

Example:

Topic Description

Ad-hoc Testing This type of testing is done without any formal Test Plan or Test Case creation. Ad-hoc
testing helps in deciding the scope and duration of the various other testing and it also
helps testers in learning the application prior starting with any other testing.

Enhancement The addition of new functionality and/or the change/removal of existing functionality in
order to improve the application.

Functional Testing | In this type of testing, the software is tested for the functional requirements. The tests
are written in order to check if the application behaves as expected.

Incident A problem with the application, test script, tester performance and/or documentation,
which prevents verification of a particular requirement or design element.

Regression The process of re-executing one or more test scripts in order to verify that errors have

Testing been properly corrected and that no new errors have been introduced.

Confidential - ©2014 Documentation Consultants (www.SDLCforms.com) Page 17 of 40



Documentation
Consultants

Offices in Philadelphia, PA,
Texas & South Florida
Phone: 215-780-0074

Email: inquiry@doccons.com

SDLCforms

System Administrator’'s Guide
Version 3.0

,A

3.7 Appendix

This section contains information that is important to the document, e.g., diagrams, graphics, and
special information. The following table provides information that may be helpful in preparing the
document and performing its quality assurance.

Description and Quality Assurance Suggestion

Document Properties

Click ‘File’ and ‘Properties’: Contains title, subject, author, and company.

Track Changes

Special side bar characters on pages to denote changes, if applicable. All
tracked changes are finalized and special side bar indicators, underlines,
colors, etc. must not be displayed unless requested by the client.

Title Page

Title, date, logo, names (company, preparer, and recipient names),
copyright notice, confidential statement and proprietary marking.

Table of Contents

Numbered and aligned correctly, no bookmark errors, displays appropriate
number of heading levels, and page numbers.

Headers and Footers

Logo, date, page number, confidentiality statement, and proprietary markings
on all pages.

Heading and Section Titles

Correctly titled, numbered, and aligned with correct size and font.

Spell and Grammar Check

Note: not all recommended changes should be implemented.

Document content

Content is technically correct, consistent, complete, and is easily understood.

Document Format and
Style

Consistent within the document and with similar documentation.

All requested and required
information is contained
within the document

Headings, sections, client data, expenses, equipment, explanations, letters,
and attachments, etc.

Acronyms

Acronyms are always spelled out first.

Appendices

Referenced in the document and correctly numbered with appropriate content.

Contact Information

Correct name, address, telephone, cell, email, and fax.

Cross-References

Item referenced correctly with appropriate content.

Date and Time

Correct content and consistent format.

Footnotes

Numbered, linked, and placed correctly.

Format

Consistent size, shape, spacing, color, alignment, indentation (bullets,
numbers, and outlining), lines, fonts, bolding, italicizing, underlines, borders,
shading, word casing (sentence, upper, lower, title), background, fill, and line
breaks.

Glossary and Definitions

Listed alphabetically or by topic and contains accurate information.

Graphics

Includes information to introduce the graphic (correct content, size, placement,
and is easily understood).
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Description and Quality Assurance Suggestion

Hyper-links Recognized as a link if online-size, color, underlined, and goes to the correct
location when keyed.
Index Listed alphabetically or by topic with correct sub levels and page numbers.

Organizational Charts

Easy to read, names and titles correct, in the right reporting order, and linked to
the appropriate area or management.

Page and Section Breaks

Appropriately placed, not too much white space on page, and keeps whole
chapters, sections, and content together.

Page Numbers

Correctly numbered and displayed in a consistent matter.

Process and Workflow
Charts

Easy to read, activity flows in a consistent order, correct activity content-uses
appropriate boxes, circles, arrows, pointers, links, connections, markings, and
end points. No missing or confusing steps.

Quotes and References

Content correct and displayed appropriately.

Special Characters

Used correctly and contains beginning and end marks, e.g., parentheses and
brackets.

Symbols

Used and placed correctly.

Table of Figures

Referenced in the document and correctly numbered with appropriate content.

Tables and Charts

Contains an introductory sentence, easy to read, correct content, size, spacing,
sorting, alignment, placement, correct row table headings and displays on each
continuing page, and rows are allowed to break across pages when specified.

Terminology

Correct usage for topic, used consistently, and can be understood.

Confidential - ©2014 Documentation Consultants (www.SDLCforms.com)

Page 19 of 40




. Offi in Philadelphia, PA,
Documentation _ Texas & South Florida . SDLCforms
Consultants # _ Phone: 2157800074 System Administrator’s Guide
Vs Email: inquiry@doccons.com VerSion 30

4 Word 2007/2010 Maintenance Information

The Document Properties area within the Microsoft software contains general information about the
document. Users should consider changing the Summary tab within the Properties page.

4.1 Updating the Document Summary Information

e Click on the File menu and then the Properties hyperlink (on right side of window), and then select
Advanced Properties to display the Properties dialog box.

@ > | Anal _and_Design_Document.doc [Compatibility Mode] - Microsoft
Home Insert Page Layout References Mailings Review View Add-Ins PDF
H Save 3 . .
- Information about Analysis_and_Design_Document
A Save As
C:\Data\SDLCferms\Documents\Analysis_and_Design_Document.doc
[ Open
J Close S
Compatibility Mode
Info \E ; Some new features are disabled to prevent problems when working with
il previous versions of Office. Converting this file will enable these features, but
ChnvatE may result in layout changes.
Recent
New
1 Size 433KB
A Permissions s
Print _'_iﬁl Anyone can open, copy, and change any part of this document. 1;3‘
Save & Send Protect otal Editing Time 18 Minutes
Document ~ Title Analysis and Design Document
Tags
Help Comments
: Prepare for Sharing
:] Options =1
(b= Before sharing this file, be aware that it contains: Relared Patex
Exit Ch‘i i Document properties, author's name and related dates Last Modified
eck for R
e Headers and footers Created
Characters formatted as hidden text Last Printed
Content that cannot be checked for accessibility issues because of the
current file type Related People
Author Ken Fass
: Versions
13 odified By ob Delae
33 %) There are no previous versions of this file. Last Modified By Bob Delaek
Manage Related Documents
Versions ~ 2
[ Open File Location
Show All Properties
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e Click on the Summary tab.

Analysis_and_Design_Dos 21

General Summary IStatistics | Contents | Customl

Title: |Analysls and Design Document

Subject: |

Author: |Documentation Consultants

Manager: |

Company:

I
Category: |
I

Keywords:

Comments:

Hyperlink |
base:

Template:  Mormal.dotm

I~ Save preview picture

oK Cancel

e Enter appropriate information within the Summary tab.

4.2 Modifying the Title Page

The Title Page contains initial descriptive document information. Users should change this information
to the specifics of the document. These items include the following:

¢ Body of Title Page
o Company Name
o Document Title

o Date
e Header and Footer Information:
o Header

= Company Logo
= Document Type, e.g., Business Case, System Test Plan
= Document Title
» Project or Version Number
o Footer
= Confidentiality Statement and proprietary markings (short and long versions)
= Page Number
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The various data elements comprising the page are shown in Figure 1-1.

Analysis and Design Document

Proje ame

| HEADER
Your Company Name
Analysis and Design Document TITLE PAGE BODY

DATE

DATE

Analysis and Designh Document

FOOTER

Figure 1-1. Title Page Data Elements

4.2.1 Modify Header Detall

To access the Header, click on the Insert Menu and then the Header icon in the Main Menu bar on the

top of the page:

Home Insert Page Layout References Mailings Review View Add-Ins PDF

- 3 =0 =
s = g2 [ ™ . Q 2 -,t:; s =5 :
| a ge 1 4=] i . = =
Cover Blank Page Table Picture Clip Shapes SmartArt Chart e Hyperlink Bookmark Cross-reference | Header Footer  Page
Page~ Page Break - Art - - Number
Pages Tables Tllustrations Links Header & Footer

SR

Text Quick WordArt D

Box~ Parts~

Tex

t

> @
|2 Signature Line ~ W Q

(33 Date & Time
*gd Object

Symbol

Symbols
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A dropdown menu will appear. Click on the Edit Header icon. The document header will appear
highlighted for you to make changes.

Analysis and Design Document
=9 ProjectName
- Version

Modify the Company Logo

To replace the default company logo, click on the logo to highlight the graphic, and then click on the
Picture icon. The Insert Picture dialog box will display. Navigate to the location of your company logo
and click on the Insert button to insert your logo. Use the handles on the graphic to size the graphic to
the desired shape and size.

Note: Since the majority of SDLCforms have multiple sections, you may need to repeat this process in
every section in the document.

Modify the Project Name

On the right hand side of the header, highlight the Project Name text and replace it with your project
name.

Modify Version

Below the Project Name, highlight the Version text and enter the version number of the document
(generally Version 1.0).

When you are complete with all changes, click on the Close Header and Footer icon to return to the title
page.
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4.2.2 Modify Title Page Body Information

Scroll over the respective line and overwrite the appropriate information (use appropriate style where
applicable):

o Replace “Your Company Name” with your company name.
o Replace “Date” with today’s date.

Your Company Name

Analysis and Desigh Document

DATE

4.2.4 Modifying the Footer Detail

To access the Footer, click on the Insert Menu and then the Footer icon in the Main Menu bar on the
top of the page:

Home Insert Page Layout References Mailings Review View Add-Ins PDF [~} @

iNEEEHEPEd. @5 B BER OE4 2 TQ

_51 Date & Time
Cover Blank Page Table Picture Clip Shapes SmartArt Chart Hyperlink Bookmark Cross-reference Header Footer Page Text Quick WordArt o Symbol
Page~ Page Break - Art v - ~  Number~| Box~ Parts~ - "$d Object ~ v

Pages Tables Illustrations Links Header & Footer

\
symbols ||

A dropdown menu will appear. Click on the Edit Footer icon. The footer will appear highlighted for you
to make changes.

To modify the confidentiality statement in the footer:

¢ Move your cursor over the statement and type the respective information.

o While the confidentiality statement is highlighted, change the statement information to black by
clicking into the statement and when the popup menu appears, click on the “A” icon to change the
color.

¢ Note that the representative illustration above only applies to Section 1 of the footer. You will need
to scan the entire document for additional sections, as most of the SDLCforms have multiple
sections due to differences in the first page layout and subsequent pages.
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To modify the page number in the footer:

e Click on the Page Number icon in the Insert menu.
o A dropdown menu will display. Click on Format Page Numbers. The Page Number Format dialog

will display.
L 2|
Mumber format: |1, 2, 3, ... LI
™ Include chapter number
Chapter starts with style: |Heading 1 v

Examples: 1-1, 1-A

Page numbering

¢ Continue from previous section

" Start at: I E‘
OK I Cancel

You can make any changes to the page nhumbering scheme you desire.

When you are complete with all changes, click on the Close Header and Footer icon to return to the title
page.
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4.3 Revision History

Update the Revision History Section by entering the respective information.

4.4 Copyright Notice
Update the Copyright Notice Section by changing the respective information.

Example:

COPYRIGHTNOTICE
Copyright©,2016,.Bocumentation’:Consuftants!

Albtightsireseryved,” Fhesenaterials are for.internaluse onty: No part-of. these materialsimaybe
reproducedypublished+inany. form. orby. anymeansy electionic-or, mechanical ineluding photocapy-or.aty
information:storage or.retrievalksystem, ner-may, the materialsbe diselosed: to:third parties withouttheswitten
authernization ef:Doeumentation Censultants.

4.5 Table of Contents

To create or update the Table of Contents, click on the References tab on the Main Menu bar on the
top of the page:

The click on the Table of Contents icon on the left hand side of the Main Menu bar.
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The Table of Contents dialog will display.

I Table of Figures | Table of Authorities |

Index

Print Preview \Web Preview
-~ -~
Heading 1 1 j Heading 1 j
HeABING 2. covononenensinmnsnsnsainenss 3 Heading 2
Heading 3. 5 Heading 3
v v
[V Show page numbers V¥ Use hyperlinks instead of page numbers
[V Right align page numbers
Tab leader: I ....... L]
General
Formats: IFrom template L‘
Show levels: |3 E‘
Options... I Modify... |

OK I Cancel I

H
Example:

TABLE OF CONTENTS
I 11 4
1.1 B B EITEE DIOLUITIEIIS .o oottt ettt e et ettt et ee et ettt et eeen et e e e e ettt e et ea e enee et ae e en e tens 4
2 System Test Description . s s 5
2.1 TR GOAIE AN D B B S e ettt ettt ettt Gl
2.2 Test Entrance and Exit Criteria. 5
221 e g =TT 1T (= OO TP PSPPSRV Gl
2212 e A T = TSP D SO Gl
2.3 I Q=TT =T LD PP Gl
3 System Test APProach . 6
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To update the Table of Contents, right click the contents of the Table of Contents and then Update
Field in the dropdown menu that displays

The following display box will appear.

21

Word is updating the table of contents. Select one of
the following options:

{* Update page numbers only
" Update entire table

| QK I Cancel

Click the Update entire table radio box, and then press the OK box to complete the effort.

4.6 Glossary

Update the Glossary Section table (if applicable) by entering the respective information.

Example:
Topic Description
Ad-hoc Testing This type of testing is done without any formal Test Plan or Test Case creation. Ad-hoc

testing helps in deciding the scope and duration of the various other testing and it also
helps testers in learning the application prior starting with any other testing.

Enhancement The addition of new functionality and/or the change/removal of existing functionality in
order to improve the application.

Functional Testing | In this type of testing, the software is tested for the functional requirements. The tests
are written in order to check if the application behaves as expected.

Incident A problem with the application, test script, tester performance and/or documentation,
which prevents verification of a particular requirement or design element.

Regression The process of re-executing one or more test scripts in order to verify that errors have

Testing been properly corrected and that no new errors have been introduced.
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4.7 Appendix

This section contains information that is important to the document, e.g., diagrams, graphics, and
special information. The following table provides information that may be helpful in preparing the
document and performing its quality assurance.

Document Properties

Description and Quality Assurance Suggestion
Click ‘File’ and ‘Properties’: Contains title, subject, author, and company.

Track Changes

Special side bar characters on pages to denote changes, if applicable. All
tracked changes are finalized and special side bar indicators, underlines,
colors, etc. must not be displayed unless requested by the client.

Title Page

Title, date, logo, names (company, preparer, and recipient names),
copyright notice, confidential statement and proprietary marking.

Table of Contents

Numbered and aligned correctly, no bookmark errors, displays appropriate
number of heading levels, and page numbers.

Headers and Footers

Logo, date, page number, confidentiality statement, and proprietary markings
on all pages.

Heading and Section Titles

Correctly titled, numbered, and aligned with correct size and font.

Spell and Grammar Check

Note: not all recommended changes should be implemented.

Document content

Content is technically correct, consistent, complete, and is easily understood.

Document Format and
Style

Consistent within the document and with similar documentation.

All requested and required
information is contained
within the document

Headings, sections, client data, expenses, equipment, explanations, letters,
and attachments, etc.

Acronyms

Acronyms are always spelled out first.

Appendices

Referenced in the document and correctly numbered with appropriate content.

Contact Information

Correct name, address, telephone, cell, email, and fax.

Cross-References

Item referenced correctly with appropriate content.

Date and Time

Correct content and consistent format.

Footnotes

Numbered, linked, and placed correctly.

Format

Consistent size, shape, spacing, color, alignment, indentation (bullets,
numbers, and outlining), lines, fonts, bolding, italicizing, underlines, borders,
shading, word casing (sentence, upper, lower, title), background, fill, and line
breaks.

Glossary and Definitions

Listed alphabetically or by topic and contains accurate information.

Graphics

Includes information to introduce the graphic (correct content, size, placement,
and is easily understood).
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Description and Quality Assurance Suggestion

Hyper-links Recognized as a link if online-size, color, underlined, and goes to the correct
location when keyed.
Index Listed alphabetically or by topic with correct sub levels and page numbers.

Organizational Charts

Easy to read, names and titles correct, in the right reporting order, and linked to
the appropriate area or management.

Page and Section Breaks

Appropriately placed, not too much white space on page, and keeps whole
chapters, sections, and content together.

Page Numbers

Correctly numbered and displayed in a consistent matter.

Process and Workflow
Charts

Easy to read, activity flows in a consistent order, correct activity content-uses
appropriate boxes, circles, arrows, pointers, links, connections, markings, and
end points. No missing or confusing steps.

Quotes and References

Content correct and displayed appropriately.

Special Characters

Used correctly and contains beginning and end marks, e.g., parentheses and
brackets.

Symbols

Used and placed correctly.

Table of Figures

Referenced in the document and correctly numbered with appropriate content.

Tables and Charts

Contains an introductory sentence, easy to read, correct content, size, spacing,
sorting, alignment, placement, correct row table headings and displays on each
continuing page, and rows are allowed to break across pages when specified.

Terminology

Correct usage for topic, used consistently, and can be understood.
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5 Word 2013 Maintenance Information

The Document Properties area within the Microsoft software contains general information about the
document. Users should consider changing the Summary tab within the Properties page.
5.1 Updating the Document Summary Information

e Click on the File menu and then Prepare and then Properties, to display the Document Properties
dialog box.

a Document Properties Location: C:\data\SDLCforms\WebSiteSourceCode\Test\Documents - Office 200 # Reguired field X

Author: Title: Subject: Keywords: Category: Status:
Documentation Consultants Project Charter business case, opportunity, go:

Comments:

e Enter appropriate information within the Document Properties tab, including replacing the Author,
entering the Subject and optionally entering the Category and Status.

5.2 Modifying the Title Page

The Title Page contains initial descriptive document information. Users should change this information
to the specifics of the document. These items include the following:

¢ Body of Title Page
o Company Name
o Document Title

o Date
¢ Header and Footer Information:
o Header

=  Company Logo
= Document Type, e.g., Business Case, System Test Plan
= Document Title
» Project or Version Number
o Footer
= Confidentiality Statement and proprietary markings (short and long versions)
= Page Number
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The various data elements comprising the page are shown in Figure 1-1.

HEADER
Your Company Name
Analysis and Design Document TITLE PAGE BODY
DATE
Your Company Name
Analysis and Desigh Document
‘ DATE
FOOTER

Figure 1-1. Title Page Data Elements

5.2.1 Modify Header Detail

To access the Header, click on the Insert Menu and then the Header icon in the Main Menu bar on the

top of the page:

Home Insert Page Layout References Mailings Review View Add-Ins PDF

Page~ Page Break

L 3 =0 = ‘
it = j EE [ p 1™ Q By = i A =
= ] | BBl 8 =] oy o) = = # —
Cover Blank Page Table Picture Clip Shapes SmartArt Chart e Hyperlink Bookmark Cross-reference | Header Footer  Page Text Quick WordArt
Art e ~ v Number~ | Box~ Parts~
Pages Tables Tlustrations Links Header & Footer

Te

xt

> @
|2 Signature Line ~ Q

Q) Date & Time
*$d Object ~

Symbol

Symbols
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A dropdown menu will appear. Click on the Edit Header icon. The document header will appear
highlighted for you to make changes.

Analysis and Design Document
=9 ProjectName
- Version

Modify the Company Logo

To replace the default company logo, click on the logo to highlight the graphic, and then click on the
Picture icon. The Insert Picture dialog box will display. Navigate to the location of your company logo
and click on the Insert button to insert your logo. Use the handles on the graphic to size the graphic to
the desired shape and size.

Note: Since the majority of SDLCforms have multiple sections, you may need to repeat this process in
every section in the document by copying the embedded (resized) graphic into the header of each
section.

Modify the Project Name

On the right hand side of the header, highlight the Project Name text and replace it with the current
project name.

Modify Version

Below the Project Name, highlight the Version text and enter the version number of the document
(generally Version 1.0).

When you are complete with all changes, click on the Close Header and Footer icon to return to the title
page.
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5.2.2 Modify Title Page Body Information

Scroll over the respective line and overwrite the appropriate information (use appropriate style where
applicable):

o Replace “Your Company Name” with your company name.
o Replace “Date” with today’s date.

Your Company Name

Analysis and Desigh Document

DATE

5.2.4 Modifying the Footer Detall

To access the Footer, click on the Insert Menu and then the Footer icon in the Main Menu bar on the
top of the page:

Home Insert Page Layout References Mailings Review View Add-Ins PDF o @

b =8 < [’ =| = Signature Line
BDEREHZEPPAL. Q3 B BER EHE4 = Q
= 4 o — {5y Date & Time
Cover Blank Page Table Picture Clip Shapes SmartArt Chart Hyperlink Bookmark Cross-reference Header Footer Page Text Quick WordArt C 2 Symbol
Page~ Page Break v Art v v ~  Number~ | Box~ Parts~ = "4 Object ~ &

Pages Tables Tllustrations Links Header & Footer Text Symbols

A dropdown menu will appear. Click on the Edit Footer icon. The footer will appear highlighted for you
to make changes.

To modify the confidentiality statement in the footer:

e Move your cursor over the statement and type the respective information.

o While the confidentiality statement is highlighted, change the statement information to black by
clicking into the statement and when the popup menu appears, click on the “A” icon to change the
color.

¢ Note that the representative illustration above only applies to Section 1 of the footer. You will need
to scan the entire document for additional sections, as most of the SDLCforms have multiple
sections due to differences in the first page layout and subsequent pages.
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To modify the page number in the footer:

e Click on the Page Number icon in the Insert menu.
o A dropdown menu will display. Click on “Format Page Numbers.” The Page Number Format dialog

will display.
L 2|
Mumber format: |1, 2, 3, ... LI
™ Include chapter number
Chapter starts with style: |Heading 1 v

Examples: 1-1, 1-A

Page numbering

¢ Continue from previous section

" Start at: I E‘
OK I Cancel

You can make any changes to the page nhumbering scheme you desire.

When you are complete with all changes, click on the Close Header and Footer icon to return to the title
page.
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5.3 Revision History

Update the Revision History Section by entering the respective information.

Date Version Author

5.4 Copyright Notice
Update the Copyright Notice Section by changing the respective information.

Example:

COPYRIGHTNOTICE
Copyright©,2016,.Bocumentation’:Consuftants!

Albtightsireseryved,” Fhesenaterials are for.internaluse onty: No part-of. these materialsimaybe
reproducedypublished+inany. form. orby. anymeansy electionic-or, mechanical ineluding photocapy-or.aty
information:storage or.retrievalksystem, ner-may, the materialsbe diselosed: to:third parties withouttheswitten
authernization ef:Doeumentation Censultants.

5.5 Table of Contents

To create or update the Table of Contents, click on the References tab on the Main Menu bar on the
top of the page:

The click on the Table of Contents icon on the left hand side of the Main Menu bar. Scroll down to and
click on “Insert Table of Contents.”
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The Table of Contents dialog will display.

Table of Contents Iy 21 x|
Index | Table of Figures I Table of Authorities I
Print Preview Web Preview
-~ -~
Heading 1 1 :I Heading 1 :I
Lzl 11 [0 2 O 3 Heading 2
Heading 3. 5 Heading 3
~| hd|
[V show page numbers IV Use hyperlinks instead of page numbers
IV Right align page numbers
Tab leader: I ....... EI
General
Formats: IFrom template LI
Show levels: |3 5‘
Options... I Modify... |

| OK I Cancel |

i
Example:
TABLE OF CONTENTS
B S T 1 4
1.1 P BT ENIEE D OLLITIEITIS L. oot e 4
2 System Test DeSCriPtion . i s s s 5

2.1 TR GOAIE AN D B B S e ettt ettt ettt
2.2 Test Entrance and Exit Criteria.
221 Entrance Criteria
2212 Exit Criteria ...
2.3 Test Deliverables..........

3 System Test Appreach .....
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To update the Table of Contents, right click the contents of the Table of Contents and then Update
Field in the dropdown menu that displays

The following display box will appear.

Do you want to replace the selected table of contents?

Yes | Mo Cancel |

Click on the Yes button to complete the effort.

5.6 Glossary

Update the Glossary Section table (if applicable) by entering the respective information.

Example:
Topic Description
Ad-hoc Testing This type of testing is done without any formal Test Plan or Test Case creation. Ad-hoc

testing helps in deciding the scope and duration of the various other testing and it also
helps testers in learning the application prior starting with any other testing.

Enhancement The addition of new functionality and/or the change/removal of existing functionality in
order to improve the application.

Functional Testing | In this type of testing, the software is tested for the functional requirements. The tests
are written in order to check if the application behaves as expected.

Incident A problem with the application, test script, tester performance and/or documentation,
which prevents verification of a particular requirement or design element.

Regression The process of re-executing one or more test scripts in order to verify that errors have

Testing been properly corrected and that no new errors have been introduced.
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5.7 Appendix

This section contains information that is important to the document, e.g., diagrams, graphics, and
special information. The following table provides information that may be helpful in preparing the
document and performing its quality assurance.

Document Properties

Description and Quality Assurance Suggestion
Click ‘File’ and ‘Properties’: Contains title, subject, author, and company.

Track Changes

Special side bar characters on pages to denote changes, if applicable. All
tracked changes are finalized and special side bar indicators, underlines,
colors, etc. must not be displayed unless requested by the client.

Title Page

Title, date, logo, names (company, preparer, and recipient names),
copyright notice, confidential statement and proprietary marking.

Table of Contents

Numbered and aligned correctly, no bookmark errors, displays appropriate
number of heading levels, and page numbers.

Headers and Footers

Logo, date, page number, confidentiality statement, and proprietary markings
on all pages.

Heading and Section Titles

Correctly titled, numbered, and aligned with correct size and font.

Spell and Grammar Check

Note: not all recommended changes should be implemented.

Document content

Content is technically correct, consistent, complete, and is easily understood.

Document Format and
Style

Consistent within the document and with similar documentation.

All requested and required
information is contained
within the document

Headings, sections, client data, expenses, equipment, explanations, letters,
and attachments, etc.

Acronyms

Acronyms are always spelled out first.

Appendices

Referenced in the document and correctly numbered with appropriate content.

Contact Information

Correct name, address, telephone, cell, email, and fax.

Cross-References

Item referenced correctly with appropriate content.

Date and Time

Correct content and consistent format.

Footnotes

Numbered, linked, and placed correctly.

Format

Consistent size, shape, spacing, color, alignment, indentation (bullets,
numbers, and outlining), lines, fonts, bolding, italicizing, underlines, borders,
shading, word casing (sentence, upper, lower, title), background, fill, and line
breaks.

Glossary and Definitions

Listed alphabetically or by topic and contains accurate information.

Graphics

Includes information to introduce the graphic (correct content, size, placement,
and is easily understood).
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Description and Quality Assurance Suggestion

Hyper-links Recognized as a link if online-size, color, underlined, and goes to the correct
location when keyed.
Index Listed alphabetically or by topic with correct sub levels and page numbers.

Organizational Charts

Easy to read, names and titles correct, in the right reporting order, and linked to
the appropriate area or management.

Page and Section Breaks

Appropriately placed, not too much white space on page, and keeps whole
chapters, sections, and content together.

Page Numbers

Correctly numbered and displayed in a consistent matter.

Process and Workflow
Charts

Easy to read, activity flows in a consistent order, correct activity content-uses
appropriate boxes, circles, arrows, pointers, links, connections, markings, and
end points. No missing or confusing steps.

Quotes and References

Content correct and displayed appropriately.

Special Characters

Used correctly and contains beginning and end marks, e.g., parentheses and
brackets.

Symbols

Used and placed correctly.

Table of Figures

Referenced in the document and correctly numbered with appropriate content.

Tables and Charts

Contains an introductory sentence, easy to read, correct content, size, spacing,
sorting, alignment, placement, correct row table headings and displays on each
continuing page, and rows are allowed to break across pages when specified.

Terminology

Correct usage for topic, used consistently, and can be understood.
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